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 PLUS TWO COMPUTER APPLICATION ( HUMANITIES ) 

 18+ Target  Study Material ( prepared by : Nikhil Vinayak ) 

 5 Mark Questions 
 1.  DBMS നിർവചി�ുക  DBMS  െ�  �ന��ൾ  ചുരു�ി വിവരി�ുക 

 DBMS നിർവചി�ുക 
 ഡാ�ാ�ബസിൽ ഡാ�െയ ��ാർ 
 െച���തിനും,എടു�ു�തിനും,ൈകകാര�ം 
 െച���തിനും ഉപ�യാഗി�ു� �സാഫ്�് െവയർ 
 ടൂളാണ്.  ഉദാ:MySQL 

 DBMS  െ�  �ന��ൾ 

 ●  ഡാ� റിഡൻഡൻസി നിയ��ി�ു�ു 
 ●  ഡാ� കൺസി�ൻസി 
 ●  എഫിഷ�� ഡാ� ആക്സസ് 
 ●  ഡാ�യുെട ഇെ��ഗി�ി 
 ●  ഡാ� െസക��രി�ി 
 ●  െഷയറിങ് ഓഫ് ഡാ� 

 2.  Mail Merge  നിർവചി�ുക. Mail Merge �ൾെ��ിരി�ു�  ഘ��ൾ  എഴ�തുക. 
 െമയിൽ െമർജ്     Mail merge 

 ഒരു  �പധാന  �ഡാക��െമ��െന  ഒരു  കൂ�ം  ഡാ�യുമാ�യാ  ഡാ�ാ  ��സാത�ുകള�മാ�യാ  ലി�്  െചയ്തുെകാ�് 
 ക�ുകള�ം, െമയിലിംഗ് �ലബലുകള�ം എൻവല�ുകള�ം സൃ�ി�ാൻ െമയിൽ െമർജ് ഉപ�യാഗി�ു�ു. 
 െമയിൽ െമർജ് ��പാസ�ിെ�  ഘ��ൾ 
 Step 1 :Select starting document    /  ആരംഭി�ു� �ഡാക��െമ� തിരെ�ടു�ുക 
 Step 2: Select document type        /   �ഡാക��െമ� ൈട�് തിരെ�ടു�ുക 
 Step 3: Insert address book          /    അ�ഡസ് ബു�് �ചർ�ുക 
 Step 4 :Create salutation  /     സല���ഷൻ ത�ാറാ�ുക 
 Step 5: Adjust layout  /      �ലഔ�് �കമീകരി�ുക 
 Step 6 : Edit documents  /       �ഡാക��െമ�കൾ എഡി�് െച��ക 
 Step 7: Personalize documents /  �ഡാക��െമ�കൾ വ��ിഗതമാ�ുക 
 Step 8: Save, print or send  /        �സവ്, �പി� െച��ക അെ��ിൽ അയയ്�ുക 

 3.HTML-െല ഏെത�ിലും ര�ു  ലി�്  ലഘുവായി വിശദീകരി�ുക. 
 3.1. അൺ ഓർ�ഡർഡ്  ലി�് -  ഓർഡർ െച�ാ� ലി�ുകൾ ബു��ുകൾ െകാ�് 

 അടയാളെ�ടു�ിയിരി�ു�ു. 
 < UL>  ടാഗ് ഉപ�യാഗി�ാണ് ഓർഡർ െച�ാ� ലി�ുകൾ സൃ�ി�ു�ത്. 
 <LI >  ടാഗിനു�ിൽ ഓ�രാ ലി�് ഇന�ൾ എഴ�തു�ു. 
 ഉദാഹരണം : <UL>  Output 

 <LI>RAM</LI>  ⬤ RAM 
 <LI>ROM</LI>  ⬤ ROM 
 </UL> 

 3.2. ഓർ�ഡർഡ്  ലി�് -  ന�ർ,�റാമൻ ന�ർ,അ�ര�ൾ െകാ�് ഓർഡർ െചയ്ത് 
 അടയാളെ�ടു�ിയിരി�ു�ു. 

 < OL>  ടാഗ് ഉപ�യാഗി�ാണ് ഓർഡർ െചയ്ത ലി�ുകൾ സൃ�ി�ു�ത്. 
 <LI >  ടാഗിനു�ിൽ ഓ�രാ ലി�് ഇന�ൾ എഴ�തു�ു 
 ഉദാഹരണം : <OL>  Output 

 <LI>RAM</LI>  1. RAM 
 <LI>ROM</LI>  2. ROM 
 </OL> 
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 3 Mark Questions 
 Chapter 1 : 

 1. ഡിൈസനി�ിെല (പ�ിഷി�ിെല)  ഏെത�ിലും ഘടക�ൾ (elements ) വിശദീകരി�ുക� 

 ANS :  ൈലൻ, െഷയ്�്, കളർ, സ്�പസ്, ൈട��ാ�ഗഫി 

 2.  ഡിൈസനി�ിെല  (പ�ിഷി�ിെല)  തത��ൾ  ( �പിൻസി�ിൾസ് ഓഫ് ഡിൈസൻ ) വിശദീകരി�ുക� 

 ANS :  ബാലൻസ്, റീെപ�ീഷൻ, �കാൺ�ടാസ്റ് , ഹാർമണി, യൂണി�ി , െഡാമിനൻസ് 

 3. പ�ിഷി�ിെല വ�ത�സ്ത തരം �പി��ങ് �പ�കിയകൾ ഏെത�ാം� 

 ANS  : ലി��ാ�ഗാഫിക് �പി��ങ്,ഡിജി�ൽ �പി��ങ്,��ഗവിയർ �പി��ങ്,െ�ക്�സാ�ഗാഫി,സ്�കീൻ �പി��ങ് 
 4. പ�ിഷി�ിെല �പാ�് �പ�ിെ� വിവിധ ഘ��ൾ ചുരു�ി വിശദീകരി�ുക� 

 ANS  : 
 ●  �ഫാൾഡിങ്   : �പി� െചയ്തു വ� �പജുകെള മട�ു� രീതി.. 
 ●  അ�ം�ിങ്    : �പി� െചയ്ത എ�ാ �പജുകള�ം �കമ�ിൽ കൂ�ി��ർ�ു�ു. 
 ●  **ൈബൻഡിങ്  : ഹാൻഡ് കവർ,സ്ൈപറൽ,െതർമൽ ,�ി��ഡ് എ�ിവ 
 ●  ക�ിങ് :�പജുകളിെല ��കാപ് മാർ�ിെന �പജുകൾ മുറി��മാ�ു�ു. 

 5. ഇല���ാണിക് പ�ിഷിങ് എ�ാൽ എ�്� ര�ുതരം ഇല���ാണിക് പ�ിഷിംഗ് ഏെത�ാം � 

 ANS :  ഇ-ബു�ുകൾ, ഡിജി�ൽ മാസികകൾ എ�ിവയുെട ഡിജി�ൽ �പസി�ീകരണമാണിത്. 
 2 തരം ഇല���ാണിക് പ�ിഷിംഗ് : െവബ് �ബസ്ഡ് പ�ിഷിംഗ്, ഡിജി�ൽ ഡിസ്�ടിബൂഷൻ / ഡിജി�ൽ പ�ിഷിംഗ് 

 Chapter 2 : 

 1. �വഡ് ��പാസസറുകള�െട സവി�ശഷതകൾ ചുരു�ി വിശദീകരി�ുക� 

 ANS :  സ്പീഡ് : �ഡാക��െമ�  �വഗ�ിൽ ത�ാറാ�ാം. 

 എഡി�ിംഗ് : വാചകം �ചർ�ൽ,ഇ�ാതാ�ൽ, പകർ�ൽ തുട�ിയ �പ�കിയ. 

 �ടബിൾ : ഡാ�കെള വരിയും നിരയുമു� �ടബിള�കൾ ആയി അവതരി�ി�ാം. 

 2. writer െല ‘Cut-paste’, ‘Copy-paste’ താരതമ�ം െച��ക� 

 ANS : 

 ക�്-�പ�് ( Cut-Paste )  �കാ�ി-�പ�് ( Copy Paste ) 

 െടക് സ് �് ഡ���ി���് െച���ി�  െടക് സ് �് ഡ���ി���് െച���ു. 

 െടക് സ് �് െഡ�ി�നഷനിൽ മാ�തം കാണു�ു.  െടക് സ് �് �സാഴ്സിലും െഡ�ി�നഷനിലും കാണു�ു. 

 െടക്�ിെന ഒരു �ല�ുനി�ും മെ�ാരു �ല���് നീ�ു�ു.  െടക്�ിെ� �കാ�ി മെ�ാരു �ല�ു എ�ി�ു�ു. 

 4. ൈറ�ർ IDE യിെല ഘടക�ൾ ഏെത�ാം� 

 ANS  :  ൈട�ിൽ ബാർ, .െമനു ബാർ, ടൂൾ ബാർ, സ്��കാൾ ബാർ, റൂളർ, �ാ�സ് ബാർ,െടക്�് ഏരിയ 

 5. Drop caps എ�ാൽ എ�്� writer-ൽ ഉൾെപടു�ു�തിനു� മാർഗ�ൾ ഏെത�ാം� 

 ANS  :  ആദ� പാര�ഗാഫിെല ആദ� അ�രം, ര��ാ അതിലധിക�മാ വരികള�െട ഉയരം എടു���ാം. 

 Step 1 : പാര�ഗാഫിൽ കഴ്സർ �ാപി�ുക 
 Step 2 :പാര�ഗാഫ്  ഡയ�ലാഗ് �ബാക്സ് തുറ�് ��ഡാ�് ക�ാപ്സ് ടാബ് തിരെ�ടു�ുക. 
 Step 3 :��ഡാ�് ക�ാപ്സ് െച��� അ�ര�ള�െട എ�ം ,സ്പാൻ െച��� വരികള�െട എ�ം നൽകുക. 
 Step 4 :Ok ബ�ൺ �ി�് െച��ക. 

 Chapter 3 : 

 1. എ�ാണ് വാ�ർമാർക്� വാ�ർമാർക് ഉൾെ�ടു�ു� വിധം � 

 ANS :  �ഡാക��െമ��െ� ബാ�്�ഗൗ�ിൽ കാണു� വാചകെ� വാ�ർമാർ�് എ�് 

 വിളി�ു�ു.�ഡാക��െമ��െന pdf ആയി എക്സ്�പാർ�് െച��� സമയ�ു മാ�ത�മ 

 വാ�ർമാർക് ഉൾെപടു�ാൻ സാധി�ു. 

 Step 1 : �ഡാക��െമ� ഓ�ൺ െച��ക. File - > Export as PDF െസല�് െച��ക. 
 Step 2: വാ�ർമാർക് ൈട�് െച��ക.Click Export & ഫയലിെ� �പര് നൽകി �സവ് െച��ക. 
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 2. ലിെ�ബ ഓഫീസ് writer �ഡാക��െമ��ൽ ഉൾെ�ടു�ാവു� 3 തരം �ഗാഫിക് ഉ�ട�ം ഏെത�ാം � 
 ANS  : ചി�ത�ൾ, ചാർ��കൾ, �ഷ�്(��ഡായിംഗ് ടൂള�കൾ) 

 Chapter 4 : 
 1.�ാ�ിക് & ൈഡനാമിക് െവബ് �പജുകൾ ത�ിലു� വ�ത�ാസം� 

 ANS: 

 �ാ�ിക് െവബ് �പജുകൾ  ൈഡനാമിക് െവബ് �പജുകൾ 

 െവബ് �പജിെ� ഉ�ട�വും �ലഔ��ം �ിരമായിരി�ും.  ഉ�ട�വും �ലഔ��ം മാറിെ�ാ�ിരി�ും 

 ഡാ�ാ�ബസ് ഉപ�യാഗി�ു�ി�.  ഡാ�ാ�ബസ് ഉപ�യാഗി�ു�ു. 

 െവബ് �പജുകൾ വികസി�ി�ാൻ എള��മാണ്  െവബ് �പജുകൾ വികസി�ി�ാൻ �പയാസമാണ്. 

 2. <BODY> ടാഗിെ� ഏെത�ിലും 6 attributes എഴ�തുക� 
 ANS :  Bgcolor, Background, Text, Link, Vlink, Alink 

 3. <HTML> ടാഗിെ� 2 attributes ഏെത�ാം� അതിെ� ഉപ�യാഗം എഴ�തുക� 
 ANS :  (1)Lang : െവബ് �പജിെല ഭാഷ വ��മാ�ാൻ 

 (2) Dir : െവബ് �പജിൽ �പദർശി�ി��� വാചക�ിെ� ദിശ വ��മാ�ാൻ 
 4. HTML െ� അടി�ാന ഘടന എഴ�തുക� 

 <html> 
 <head> <title>�പജിെ� തലെ��് ഇതിൽ നൽകു�ു</title> </head> 
 <body> െവബ് �പജിൽ കാണു� ഉ�ട�ം ഇതിൽ നൽകു�ു</body> 

 </html> 

 Chapter 5: 
 1. <TABLE> ടാഗിെ� ആ�ടിബ����കൾ ലി�് െച��ക� 

 ANS : border,width, height, align, bgcolor, cellspacing 
 Chapter 6: 

 1. CSS-െല െസ�ർ എ�ാൽ എ�്� വിവിധ തരം െസെല�റുകൾ ലി�് െച��ക� 
 ANS :  Selector  : ൈ�ൽ റൂൾ അൈ� െച��� HTML എെലെമ�ാണ് െസല�ർ. 

 യൂണി�വഴ്സൽ െസല�ർ  ,  ൈട�് െസല�ർ,�ാസ് െസല�ർ, ഐഡി െസല�ർ 

 Chapter 7  : 
 1. ഇനി പറയു�വ നിർവചി�ുക :   (a) Free �ഹാ�ിങ്   (b) CMS     (c) Responsive web design � 
 ANS :  ( a )  �ഫീ �ഹാ�ിംഗ് :  െവബ് �പജുകൾ യാെതാരു െചലവും കൂടാെത �ഹാ�് െച�ാൻ സാധി�ു�ു. 

 ( b )  കെ�� മാ�നജ് മ� സി�ം :  ൈഡനാമിക് െവബ് ൈസ�ുകൾ നിർമി�ുക,നിയ��ി�ുക,പ�ിഷ് 
 െച���തിനു� െവബ് �സാഫ്�് െവയർ ടൂൾ.  ഉദാഹരണം :  WordPress, Drupal, Joomla 

 ( c ) െറസ്�പാൺസീവ് െവബ് ഡിൈസൻ:  സ്�കീൻ വലി�ം പരിഗണി�ാെത എ�ാ ഡിൈവസുകളിലും 
 ഒ�ര�പാെല െവബ്ൈസ�് ദൃശ�മാ�ു�തിനായി ഉപ�യാഗി�ു�ു. 

 2. Shared hosting ഉം dedicated hosting ഉം താരതമ�ം െച��ക� 
 ANS : 

 Shared hosting  Dedicated hosting 

 കുറ� ചിലവ്, െചറിയ െവബ് ൈസ�ുകൾ�് അനു�യാജ�ം  ഉയർ� ചിലവ്, വലിയ െവബ് ൈസ�ുകൾ�് അനു�യാജ�ം 

 CPU,RAM,STORAGE തുട�ിയവ  മ�ു �യ��മായി പ�ിടു�ു.  CPU,RAM,STORAGE തുട�ിയവ ഒരു �യ��ന് മാ�തം 

 �ടാഫിക് വർ�ി�ു��ാൾ �വഗത കുറയാൻ സാധ�തയു�്  ഉയർ� �പകടനം, �വഗത�യറിയ �ലാഡിംഗ് സമയം 

 3. FTP �യ� �സാഫ്�് െവയറുകള�െട ഉപ�യാഗം എ�്� ഉദാഹരണം എഴ�തുക� 
 FTP �യ� �സാഫ്�് െവയർ  : ന�ുെട ക����റിൽ നി�ു�  െവബ്ൈസ�് ഫയലുകെള െവബ് 

 െസർവറി�ല�് അപ് �ലാഡ് െച���തിനു� �സാഫ്�് െവയർ.  ഉദാ  : FileZilla,CuteFTP, Smart FTP 
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 Chapter 8: 
 1. Database അഡ്മിനിസ്��ട�ർ െ� കർ�വ��ൾ ( Duties of DBA )എെ��ാം � 
 ANS :    സ്കീമ ഡിൈസൻ െച���ു, െസക��രി�ി & ഓതൈറസഷൻ,ഡാ� അൈവലബിലി�ി & 

 റി�വറി �ഫം െഫയി�ലർസ് 
 4. RDBMS-ൽ ഉപ�യാഗി�ു� കീ കള�െട തര�ൾ പ�ികെ�ടു�ുക� 

 ANS :  ൈ�പമറി കീ : ഒരു �ടബിളിെല ഓ�രാ െറ��ാർഡിെനയും  തനതായി തിരി�റിയാൻ ഉപ�യാഗി�ു�ു. 
 �ഫാറിൻ കീ  : ര�് �ടബിള�കൾ ത�ിലു� ബ�ം �ാപി�ാൻ ഉപ�യാഗി�ു�ു. 
 ആൾ�ർ�ന�് കീ : ഒരു �ടബിളിെല ൈ�പമറി കീ അ�ാ� കാൻഡി�ഡ�് കീകൾ ആൾ�ർ�ന�് കീയാണ്. 

 Chapter 9  : 
 1. SQL- ൽ  ഇനി പറയു�വ  ഘടക�ൾ വിശദീകരി�ുക  :  (a) DDL      (b)      DML    (c) DCL  � 

 ANS :  ( a ) ഡാ� െഡഫനിഷൻ ലാം�ഗ�ജ്  :  ഡാ�ാ�ബസിൽ �ടബിൾ നിർമി�ുക, പരിഷ്കരി�ാം,നീ�ം െച�ാം 

 COMMANDS : CREATE TABLE,ALTER TABLE,DROP TABLE 
 ( b )  ഡാ� മാനിപു�ലഷൻ ലാം�ഗ�ജ് : �ടബിളി�ല�് പുതിയ �റാകൾ കൂ�ി��ർ�ാം,നിലവിെല 

 �റാകെള പരിഷ്കരി�ാം,�റാകെള നീ�ം െച�ാം.  COMMANDS :  INSERT INTO, SELECT, UPDATE,DELETE 

 ( C ) ഡാ� കൺ��ടാൾ ലാം�ഗ�ജ് :  ഡാ�ാ�ബസി�ല�ു� ആക്സസ് നിയ��ി�ാൻ ഉപ�യാഗി�ു�ു 

 COMMANDS :  GRANT,REVOKE 
 2. SQL ൽ CHAR, VARCHAR എ�ീ ഡാ� ൈട�ുകൾ താരതമ�െപടു�ുക� 

 ANS : 
 CHAR  VARCHAR 

 ഇത് fixed length ഉ� സ്�ടിംഗ് ഡാ� ൈട�ാണ്.  ഇത് variable length ഉ� സ്�ടിംഗ് ഡാ� ൈട�ാണ്. 

 ഇതിൽ പരമാവധി 255 character ��ാർ െച�ാം.  ഇതിൽ പരമാവധി 65535 character ��ാർ െച�ാം. 

 െമ�റി അ�ലാ��ഷൻ �ാ�ി�ാണ്.  െമ�റി അ�ലാ��ഷൻ ൈഡനാമിക് ആണ്. 

 3. SQL-െല ഡാ�ാൈട�ുകൾ വിശദീകരി�ുക� 
 ANS :  �ടബിളിെ� �കാള�ിൽ നൽകി�യ�ാവു� വാല��വിെ� ൈട�് 
 ന��െമറിക് ഡാ� ൈട�് :  INTEGER പൂർ�സംഖ�കെളയും,DECIMAL ദശാംശ സംഖ�കെളയും 

 �പതിനിധീകരി�ു�ു. 
 സ്�ടിംഗ് (െടക്�് ) ഡാ� ൈട�് :  CHARACTER  അ�ര�െളയും, VARCHAR വാ�ുകെള 

 �പതിനിധീകരി�ാൻ ഉപ�യാഗി�ു�ു. 
 �ഡ�്  തീയതികൾ സംഭരി�ു�തിന് &  ൈടം ഡാ� ൈട�്  സമയ മൂല��ൾ സംഭരി�ു�തിന് 

 4. SQL-െല 3  �കാളം കൺസ്�ടയി�സ് ലി�് െച��ക� 
 ANS : NOT NULL, AUTO_INCREMENT,UNIQUE,DEFAULT,PRIMARY KEY,FOREIGN KEY 

 Chapter 10  : 
 1. െമാൈബൽ ആശയവിനിമയ�ിെ�  ( െമാൈബൽ ക���ണി��ഷൻ സർവീ�് )  �സവന�ൾ ഏെത�ാം� 

 ANS :  �ഷാർട് െമ��ജ് സർവീസ് ( SMS ) :  െമാൈബൽ �ഫാണുകൾ ത�ിൽ പരമാവധി 160 അ�ര�ൾ 
 വെരയു� െചറിയ െടക്�് െമ��ജ് അയ�ാനു� സംവിധാനം. 

 മൾ�ീമീഡിയ െമ��ജിങ് സർവീസ്  : മൾ�ിമീഡിയ സ��ശ�ൾ അയയ് �ാനു�  സംവിധാനം. 
 ��ാബൽ െപാസിഷനിംഗ് സി�ം : ഉപ�ഗഹെ� അടി�ാനമാ�ിയു� നാവി�ഗഷൻ സംവിധാനമാണ്. 
 സ്മാർ�് കാർഡുകൾ : െമ�റിയും ��പാസസറും അട�ു�ചി��ാടുകൂടിയ �ാ�ിക് കാർഡ്. ഉദാ : സിം കാർഡ് 
 2. എ�ാണ് ൈസബർ കു�കൃത��ൾ� വ��ികൾെ�തിരായ ൈസബർ കു�കൃത��ൾ വിശദീകരി�ുക� 

 ANS :  ൈസബർ കു�കൃത�ം : ക����ർ, െമാൈബൽ �ഫാൺ, ഇ�ർെന�് എ�ിവ ഉപ�യാഗി��� �കിമിനൽ 
 �പവർ�ന�ൾ. 

 വ��ികൾെ�തിരായ വിവിധ ൈസബർ കു�കൃത��ൾ 
 ഐഡ���ി െതഫ് റ് :  ഒരാള�െട യൂസർ െനയിം,പാ�് �വർഡ് �മാ�ി�ുക. 
 ശല�െ�ടു�ൽ :  വ��ികൾെ�തിെരയു� അപമാനകരമായ കമ��കൾ �പാ�് െച��ക. 
 ആൾമാറാ�വും വ�നയും :  വ�ാജ അ�ൗ�ുകൾ നിർമി�� മ�ു�വെര ചതി�ു�ു. 
 സ�കാര�തയുെട ലംഘനം :  മ�ു�വരുെട ഡാ�,�ഫാ��ാ തുട�ിയവ വിതരണം െച���ു. 

 അ�ീലമായവ �പചരി�ി�ുക  : അ�ീല വീഡി�യാ,�ഫാ��ാ വിതരണം െച��ക  . 
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 2 Mark Questions 
 Chapter 1  : 

 1. നിർവചി�ുക : (a)  പ�ിഷിംഗ്     (b) �പീൈ��ിങ് 
 ANS  :  (a) പ�ിഷിംഗ് : വിവര�ൾ െപാതുജന�ൾ�് ലഭ�മാ�ു�തിനു� �പവർ�നം. 

 (b) �പീൈ��ിങ് : �പി���ിനു മു�് �പജുകൾ എ�ാം കൃത�മായി�് ഉ��ാ എ�് പരി�ശാധി�ും 

 2. പ�ിഷിംഗ് -െല നാല് �പീ�പസ് �പവർ�ന�ൾ( ആ�ിവി�ികൾ) എഴ�തുക� 
 ANS :  A.ഡിൈസനിങ്       B.�പീ-ൈ��ിങ്      C.�കി�യ�ിങ് �പൂഫ്         D.�പി��ങ് ���്സ് 

 3. ൈട��ാ�ഗാഫി നിർവചി�ുക.  ANS  :  �ഡാക��െമ� വായി�ാവു�തും മ�നാഹരവുമാ�ു�തിനും  അ�ര�ൾ 

 �കമീകരി�ു�തിനു�  സാ��തികത.  2 തര�ിലു�്  സാൻസ് െസരിഫ് : പാദ�ളി�ാ� �ഫാ�ുകൾ, 
 െസരിഫ് : പാദ�ള��  �ഫാ�ുകൾ. 

 4. ഇ-ബു�് റീഡറിെന�ുറി�് ഒരു െചറിയ കുറി�് എഴ�തുക� 
 ANS  : ഡിജി�ൽ പുസ്തക�ൾ ( ഇ-ബു�ുകൾ ) വായി�ു�തിനു� ഒരു  �പാർ�ബിൾ ഇല���ാണിക് 

 ഉപകരണമാണ്. ഉദാ :  ആമ�സാൺ കിൻഡിൽ, ആ�ിൾ ഐപാഡ് 

 5.  PDF �ഡാക��െമ��കൾ  വായി�ാൻ ഉപ�യാഗി�ു� �സാഫ്�് െവയർ ഏെത�ാം � 
 ANS  : : അ�ഡാബി റീഡർ, �ഫാക്സി�്  , google ��കാം ,Open O�ce.org , Nitro PDF 

 Chapter 2  : 
 1. ലിെ�ബ ഓഫീസ് ൈറ�റിെല ഏെത�ിലും നാല് നാവി�ഗഷൻ കീകൾ ലി�് െച��ക� 

 ANS :  ആ�രാ കീ, �ഹാം കീ, �പജ് അ�്,�പജ് െഡൗൺ 
 2. ൈറ�റിൽ ഒരു �ഡാക��െമ��െ� �പി� ഔ�് എടു�ു�തിനു� ഘ��ൾ എഴ�തുക. 
 ANS  : File->Print അെ��ിൽ Ctrl+P ഉപ�യാഗി�ു�ു 

 Chapter 3  : 
 1. ൈറ�റിൽ ഒരു ചി�തം �ചർ�ു�തിനു� ര�് വഴികൾ എഴ�തുക� 

 ANS :  Insert -> Image -> From file. / OR   Use  standard ToolBar െല Image icon 
 2.  ലിെ�ബ ഓഫീസ് ൈറ�ർ ഉപ�യാഗി�് ഒരു �ഡാക��െമ��ൽ ഒരു പ�ിക സൃ�ി�ു�തിനു� ഘ��ൾ എഴ�തുക. 

 ANS :  Menu bar -> Insert -> Table അെ��ിൽ  Ctrl+F12  െ�പ�് െച��ക 
 Chapter 4  : 

 1. കെ�യ്നർ ടാഗും എംപ്�ി ടാഗും ത�ിലു� വ�ത�ാസം എഴ�തുക. ഓ�രാ�ിനും ഒരു ഉദാഹരണം നൽകുക. 
 ANS :  കെ�യ്നർ ടാഗ് : ഓ�ണിംഗ് ടാഗും ��ാസിംഗ് ടാഗും ആവശ�മു� ടാഗുകൾ.  ഉദാഹരണം::  <HTML></HTML> 
 എംപ്�ി  ടാഗ്  : ഓ�ണിംഗ് ടാഗ് മാ�ത�മയു��.     ഉദാഹരണം: : <BR>, <IMG>,<HR> 
 2. HTML-െല ഏെത�ിലും നാല് െടക്�് �ഫാർമാ�ിംഗ് ടാഗുകൾ പ�ികെ�ടു�ി വിശദീകരി�ുക� 
 ANS :  <B> :  �ബാൾഡ് ആ�ു�ു  ,   <I> :  ഇ�ാലിക്   ആ�ു�ു  ,  <U>  അ�ർ  ൈലൻ നൽകു�ു,  <S>:  സ്ൈ�ട�്  നൽകു�ു 

 3. എ�ാണ് <MARQUEE> ടാഗ് � <MARQUEE>ടാഗിെ� ഏെത�ിലും ര�് ആ�ടിബ����കൾ എഴ�തുക� 

 ANS :  െവബ് �പജിൽ െടക്�ുകള�ം ചി�ത�ള�ം സ്��കാൾ  െച�ാൻ ഉപ�യാഗി�ു�ു. 
 ആ�ടിബ����കൾ  :  Direction, width,  height, Bgcolor. Loop 

 Chapter 6  : 
 1. CSS െ� ഏെത�ിലും ര�് ഗുണ�ൾ ലി�് െച��ക� 
 ANS  :  �ലഔ�് എള���ിൽ മാ�ം ,െവബ് �പജിെല �കാഡുകള�െട  എ�ംകുറയ്�ാം , 

 ബാൻഡ് വിഡ്ത്  കുറയ്�ാം , െവബ്ൈസ�ിെല �പജുകൾ എ�ാ ഒ�ര�പാെല ദൃശ�മാ�ാം. 
 2. CSS -െല ൈ�ൽ റൂൾ നിർവചി�ുക.അതിെ� syntax എഴ�തുക� 

 ANS :  ൈ�ൽ റൂൾ : െവബ് �പജിൽ െടക്�്, ചി�തം,  പാര�ഗാഫ്, ബ�ൺ etc എ�െന �പദർശി�ി�ണെമ�് 
 �ബൗസറിൽ നൽകു� നിർ�ദശം.      Syntax :  െസ�ർ{  ��പാ�ർ�ി:വാല��;} 

 3.  CSS െ� പൂർണരൂപം. െവബ് �പജിൽ CSS ഉൾെ�ടു�ാൻ ഉപ�യാഗി�ു� വ�ത�സ്ത രീതികൾ ഏെത�ാം  � 
 ANS :  ഇൻൈലൻ ൈ�ൽ ഷീ�്, ഇെ�ർണൽ ൈ�ൽ ഷീ�് , എക്��ണൽ ൈ�ൽ ഷീ�് 
 4. CSS-െല ഏെത�ിലും ര�് െസല�റുകെള�ുറി�് ചുരു�ി വിശദീകരി�ുക� 

 ANS:  യൂണി�വഴ്സൽ െസല�ർ  : ഒരു HTML �പജിെ� എ�ാ ടാഗ് ഘടക�ൾ�ും ഒ�ര�പാെല ഡി��റഷൻ 
 നല്കു�താണിത്.    ഉദാഹരണം :  *{ color: white;} 

 ൈട�് െസല�ർ  : ഇവിെട െസെല�ർ ആയി ടാഗിെ� �പര് നൽകു�ു.   ഉദാഹരണം ::  P{ color: white;} 
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 Chapter 8  : 
 1. നിർവചി�ുക:   (എ) ഡി�ഗി    (ബി) കാർഡിനാലി�ി 
 ANS :  ഡി�ഗി : റി�ലഷനിെല ആ�ടിബ����കള�െട എ�ം    |    കാർഡിനാലി�ി : റി�ലഷനിെല ട�ിള�കള�െട എ�ം 

 Chapter 10  : 
 1. ഒരു െമാൈബൽ ഓ��റ�ിംഗ് സി��ിെ� �പവർ�ന�ൾ ( functions  ) എെ��ാമാണ്� 

 ANS :  ��പാസ�് മാ�നജ് െമ�, െമ�റി മാ�നജ് െമ�, ഫയൽ മാ�നജ് െമ�, �സാഫ്�് െവയർ മാ�നജ് െമ� 

 1 Mark Questions 
 CH 1.1: DTP �സാഫ്�് െവയറിന് ഒരു ഉദാഹരണം എഴ�തുക� :  സ് �കിബസ് 

 CH 1.2 : PDF െ� പൂർ� രൂപം എഴ�തുക.  �പാർ�ബിൾ �ഡാക��െമ� �ഫാർമാ�് 

 CH 1.3 :  �പി��ംഗ് ���് ആവശ�മി�ാ� �പി��ംഗ് �പ�കിയ.  ഡിജി�ൽ �പി��ംഗ് 

 CH 2.1 :Undo �പവർ�ന�ിനു� �ഷാർട് -ക�്  കീ :  Ctrl + Z 

 CH 2.2: ഒരു ഫയൽ �സവ് െച���തിനു� �ഷാർ�് ക�് കീ ______ ആണ്�  Ctrl+S 

 CH 2.3 ൈറ�റിൽ ______ �ചർ�ു�തിനു� �ഷാർ�് ക�് കീ ആണ് Ctrl+F12�  Table 

 CH 2.4 എ�ാ �പജുകള�െടയും മുകളിൽ കാണു� െടക്�് ______ ആണ്�  െഹ�ർ 

 CH 2.5 : OLE എ�തിെ� പൂർണ രൂപം�  ഒബ്ജക്�് ലി�ിംഗ് & എംെബഡ് ഡിങ് 

 CH 2.6: �ബാൾഡ് ബ�ൺ___ ടൂൾ ബാറിൽ  ഉ�്� (a) Standard (b) Formatting (c) Drawing�  Formatting 

 CH 4.1 : HTTPS എ�ാൽ ________ ആണ്�    :  Hypertext Transfer Protocol Secure 

 CH 4.2: HTML �പജുകൾ�ു�ിൽ എഴ�തിയിരി�ു� ��പാ�ഗാം �കാഡുകളാണ്____ �  Script 
 CH 4.3: �സാഫ്�് െവയർ �പാർ�് ന�റിൽ ഉപ�യാഗി�ു� ബി�ുകള�െട എ�ം�  16 
 CH 4.4: കൂ��ിൽ നി�്  Empty ടാഗ് തിരെ�ടു�ുക: (a) <FONT> (b) <B> (c) <|> (d) <IMG> �  <IMG> 
 CH 5.1:  HTML ഫയലിൽ വീഡി�യാകള�ം സംഗീതവും �ചർ�ാൻ ഉപ�യാഗി�ു� ടാഗിന് �പര് :  <EMBED> ടാഗ് 

 CH 5.2: കൂ��ിൽ �ചരാ�ത് ഏത്:   (a) <DD>     (b) <DL>    (c) <TH>  � :  <TH> 

 CH 5.2: HTML-ൽ ൈഹ�ർലി�് സൃ�ി�ാൻ ഉപ�യാഗി�ു� ടാഗ് ഏതാണ്�  <A> ടാഗ് 

 CH 5.3 : കൂ��ിൽ െപടാ�ത് : (a) TABLE (b) TR (c) TH (d) COLSPAN �  COLSPAN 

 CH 5.4 :  HTML-ൽ ___ടാഗിെ�  ആ�ടിബ���ാണ് െസൽപാഡിംഗ്� (a) <TR> (b) <TABLE> (c) <TH> (d) <TD> � :  <TABLE> 

 CH 6.1 : ടാഗ് എലെമ��ന് പകരം '#' ചി�ം ഉപ�യാഗി�ു� െസല�ർ ഏതാണ്�  ID Selector 

 CH 6.2: CSS ഫയൽ ______ എക്�ൻഷനിൽ �സവ് െച�ണം�   .  CSS 
 CH 6.3 : ഒരു  External style sheet െവബ് �പജിൽ ഉൾെ�ടു�ു�തിനു� ടാഗ്________ആണ്�  <LINK> 

 CH 6.4 :  െവബ് �പജിെല ഒെരാ� ഘടക�ിൽ ൈ�ൽ റൂൾ �പ�യാഗി�ാൻ ഉപ�യാഗി�ു� െസല�ർ _____ ആണ്� :  ID 

 CH 7.1:  െവബ് �ഹാ�ിംഗ് �സവന�ൾ നൽകു� ക�നികെള _________ എ�് വിളി�ു�ു :  web hosts 

 CH 7.2: DNS എ�ാൽ ________ ആണ്� :  Domain Name System 

 CH 7.3: CMS പൂർണരൂപം___�  കെ�� മാ�നജ് മ� സി�ം 

 CH 9.1: SQL-ൽ ഒരു പ�ിക സൃ�ി�ാൻ ഉപ�യാഗി�ു� DDL കമാൻഡ് ആണ്�  :  CREATE TABLE 

 CH 9.2: GRANT എ�ത് ______ കമാൻഡിന് ഉദാഹരണമാണ്.   (a) DDL  (b) DML (c) DCL �  DCL 

 CH 10.1: MMS െ� പൂർണരൂപം____�  Multimedia Messaging Service 

 CH 10.2:  ഭൂമിയിെല �ാന�ൾ കെ��ാൻ ഉപ�യാഗി�ു� ഉപ�ഗഹാധിഷ്ഠിത നാവി�ഗഷൻ സംവിധാനം�  GPS 

 CH 10.3 െമാൈബൽ ഓ��റ�ിംഗ് സി��ിന് ഒരു ഉദാഹരണം എഴ�തുക�   :  ആൻ��ഡായിഡ്/ios 

 CH 10.4: SMS സ��ശ�ൾ അയയ്�ാൻ ഉപ�യാഗി�ു� ��പാ��ാ��ാൾ ________ ആണ്�  SS7 

 CH 10.5:  ഐ�ഫാണിനായു� ഓ��റ�ിംഗ് സി�ം iOS വികസി�ിെ�ടു�ത് _________ ആണ്�  Apple 

 CH 10.6:  ആൻ��ഡായിഡ്  നായു� ഓ��റ�ിംഗ് സി�ം iOS വികസി�ിെ�ടു�ത് _________ ആണ്�  Google 

 teachbook.in  |  6 

http://teachbook.in/

